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COPYRIGHT

©2017 Grandstream Networks, Inc. http://www.grandstream.com
All rights reserved. Information in this document is subject to change without notice. Reproduction or
transmittal of the entire or any part, in any form or by any means, electronic or print, for any purpose without

the express written permission of Grandstream Networks, Inc. is not permitted.

The latest electronic version of this guide is available for download here:
http://www.grandstream.com/support

Grandstream is a registered trademark and Grandstream logo is trademark of Grandstream Networks, Inc.
in the United States, Europe and other countries.

CAUTION

Changes or maodifications to this product not expressly approved by Grandstream, or operation of this
product in any way other than as detailed by this guide, could void your manufacturer warranty.

WARNING

Please do not use a different power adaptor with devices as it may cause damage to the products and void
the manufacturer warranty.
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FCC Caution

Any changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation. If this equipment does cause harmful interference to radio or television reception,
which can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

e Reorient or relocate the receiving antenna.
e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.
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GNU GPL INFORMATION

GWN7610 firmware contains third-party software licensed under the GNU General Public License (GPL).
Grandstream uses software under the specific terms of the GPL. Please see the GNU General Public
License (GPL) for the exact terms and conditions of the license.

Grandstream GNU GPL related source code can be downloaded from Grandstream Web site:
http://www.grandstream.com/support/fag/gnu-general-public-license
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DOCUMENT PURPOSE

This document describes how to configure the GWN7610 via Web GUI in standalone mode, with other
GWN7610 as Master/Slave architecture and more. The intended audiences of this document are network
administrators. Please visit http://www.grandstream.com/support to download the latest “GWN7610 User

Manual’.

This guide covers following topics:

e Product Overview

e Installation

e Getting Started

e Using GWN7610 as Standalone Access Point

e Using GWN7610 as Master Access Point Controller

e Network Groups

e Client Configuration

e System Settings
e LED Schedule

o Captive Portal
¢ Bandwidth Rules

e Upgrading and Provisioning

e Experiencing the GWN7610 Wireless Access Point
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CHANGE LOG

This section documents significant changes from previous versions of the GWN7610 user manuals. Only
major new features or major document updates are listed here. Minor updates for corrections or editing are
not documented here.

Firmware Version 1.0.4.22

e Included patch for WPA2 4-way handshake vulnerability [VU#228519]

Firmware Version 1.0.4.20

e Enhanced Client Blocking and management features. [CLIENTS CONFIGURATION]
e Added support for Client Bridge. [Client Bridge]

e Added support for Syslog Server. [Logserver]

e Added support for Configurable web Ul access port. [Web HTTPS Port]

e Added support for E-mail notifications. [Email/Notification]

Firmware Version 1.0.3.21

e No major changes.

Firmware Version 1.0.3.19

e Added support for Bandwidth Rules [BANDWIDTH RULES]

e Added support for legacy 802.11b [Allow Legacy Device]

o Added support for custom wireless power [Custom Wireless Power]

e Added support for better roaming decision [Enable Voice Enterprise]

e Added support for failover master [Failover Master]

o Added options to select band per SSID [SSID Band]

e Added support for VLAN assignment via Radius [Enable Dynamic VLAN]

e Added option to selectively enable different Wi-Fi norms (802.11b/g/n) [Mode(2.4G)]

o Added option to limit clients count per SSID [Wireless Client Limit]

¢ Added option to enable/disable DHCP option 66 & 43 override [Allow DHCP options 66 and 43 override]

Firmware Version 1.0.2.108

e Added Controller protocol security enhancement [Controller Protocol Security Enhancement]
e Added support for LED control [LED SCHEDULE]

e Added support for Captive Portal [CAPTIVE PORTAL]

e Added support for Additional SSID [Additional SSID under Same Network Group]

e Added support for Wi-Fi schedule [Schedule]

e Added Client Isolation enhancement [Client Isolation]

e Added support to store Syslog locally on the unit and display it on Web GUI [Syslog]

GWN7610 User Manual
Version 1.0.4.22
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Firmware Version 1.0.2.15

e Added New Overview Page

e Added Web Ul enhancement

o Added support for Password change on first boot [Change Password on first boot]
e Added Country code selection into setup wizard

Firmware Version 1.0.1.27

e This is the initial version
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WELCOME

Thank you for purchasing Grandstream GWN7610 Enterprise Wireless Access Point. The GWN7610 is a
high-performance 802.11ac wireless access point for small to medium sized businesses, multiple floor
offices, commercial locations and branch offices. It offers dual-band 3x3:3 MIMO technology and a
sophisticated antenna design for maximum network throughput and expanded Wi-Fi coverage range. To
ensure easy installation and management, the GWN7610 uses a controller-less distributed network
management design in which the controller is embedded within the product’s Web user interface. This
allows each access point to manage a network of up to 50 GWN7610s independently without needing
seperate controller hardware/software and without a single point-of-failure.

This wireless access point can be paired with any third party routers. With support for advanced QoS, low-
latency real-time applications, 250+ client devices per AP and dual Gigabit network ports with PoE/PoE+,
the GWN7610 is an ideal wireless access point for large and small wireless network deployments.

A Caution:

Changes or maodifications to this product not expressly approved by Grandstream, or operation of this
product in any way other than as detailed by this User Manual, could void your manufacturer warranty.

Note (VU#228519): “Out of the box” Grandstream Access Points are not affected by this issue. APs with

old firmware are only affected after changing into client-bridge mode. Please refer to our white paper of
“WPA Security Vulnerability” here.

GWN7610 User Manual
Version 1.0.4.22
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PRODUCT OVERVIEW

Technical Specifications

Table 1: GWN7610 Technical Specifications

Wi-Fi Standards IEEE 802.11 a/b/g/n/ac

3x 2.4 GHz, gain 3 dBi, internal antenna
m 3x 5 GHz, gain 3 dBi, internal antenna
IEEE 802.11ac: 6.5 Mbps to 1300 Mbps
IEEE 802.11a: 6, 9, 12, 18, 24, 36, 48, 54 Mbps
IEEE 802.11n: 6.5 Mbps to 450 Mbps
IEEE 802.11b: 1, 2, 5.5, 11 Mbps
IEEE 802.11g: 6, 9, 12, 18, 24, 36, 48, 54 Mbps

*Actual throughput may vary depending on many factors including environmental conditions,

Wi-Fi Data Rates

distance between devices, radio interference in the operating environment and mix of

devices in the network

2.4GHz radio: 2.400 - 2.4835 GHz
Frequency Bands
5GHz radio: 5.150 - 5.250 GHz, 5.725 - 5.850 GHz (FCC, IC, RCM)
2.4G: 20 and 40 MHz
Channel Bandwidth
5G: 20,40 and 80 MHz

WEP, WPA/WPA2-PSK, WPA/WPA2-Enterprise (TKIP/AES), anti-hacking secure

Wi-Fi and System
boot and critical data/control lockdown via digital signatures, unique security

Securit
y certificate and random default password per device

m 3x3:3 2.4GHz, 3x3:3 5GHz

575ft. (175 meters)

*coverage range can vary based on environment

5G: 26dBm (FCC) / 20dBm (CE)

VEYAUTTHRP S - 2 4G: 26dBm (FCC) / 17dBm (CE)

*Maximum power varies by country, frequency band and MCS rate

2.4G

802.11b:-92dBm@11Mbps; 802.11g:-76dBm@54Mbps; 802.11n 20MHz:
-73dBm@MCS7; 802.11n 40MHz:-70dBm@MCS7

5G

802.11a:-94dBm@6Mbps; 801.11a:-77dBm@54Mbps; 802.11ac 20MHz:
-69dBm@MCS8; 802.11ac HT40:-65dBm@MCS9; 802.11ac 80MHz:

Coverage Range

Receiver Sensitivity

GWN7610 User Manual Page |15
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1dBm@MCS9

* Receiver sensitivity varies by frequency band, channel width and MCS rate

16 SSIDs per access point
Concurrent Clients  [J4s{0Rs
Network Interfaces 2x autosensing 10/100/1000 Base-T Ethernet Ports
Auxiliary Ports 1x USB 2.0 port, 1x Reset Pinhole, 1x Kensington lock
Indoor wall mount or ceiling mount, kits included

LEDs 3 tri-color LEDs for device tracking and status indication
IPv4, 802.1Q, 802.1p, 802.1x, 802.11e/WMM

802.11e/WMM, VLAN, TOS

Network Protocols

Network Embedded controller in GWN7610 allows it to auto-discover, auto-provision and

Management manage up to 50 GWN7610s in a network

LT NV ST\ Il Self-power adaptation upon auto detection of PoE or PoE+

DC Input: 24VDC/1A
Power over Ethernet 802.3af/802.3at compliant

Power and Green

Energy Efficiency
Maximum Power Consumption: 13.8W

Operation: 0°C to 50°C
Environmental Storage: -10°C to 60°C
Humidity: 10% to 90% Non-condensing

Unit Dimension: 205.3 x 205.3 x 45.9mm; Unit Weight: 5409

Unit + Mounting Kits Dimension: 205.3 x 205.3 x 50.9mm; Unit + Mounting Kits
Weight: 600g

Entire Package Dimension: 258 x 247 x 86mm; Entire Package Weight: 900g

Package Content GWN7610 802.11ac Wireless AP, Mounting Kits, Quick Start Guide

Physical

Compliance FCC, CE, RCM, IC
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INSTALLATION

Before deploying and configuring the GWN7610, the device needs to be properly powered up and
connected to the network. This section describes detailed information on installation, connection and
warranty policy of the GWN7610.

Equipment Packaging

Table 2: GWN7610 Equipment Packaging

Main Case Yes (1)
Mounting Bracket Yes (1)
Ceiling Mounting Bracket Yes (1)
Plastic Expansion Bolt Yes (3)
M3 NUT Yes (3)
Screw (PM 3 x 50) Yes (3)
Screw (PM 3.5 x 20) Yes (3)
Quick Installation Guide Yes (1)
GPL License Yes (1)

GWN7610 Access Point Ports

L= e i W

Figure 1: GWN7610 Ports

Table 3: GWN7610 Ports Description

Power Power adapter connector (24V, 1A)

NET/PoE Ethernet RJ45 port (10/100/1000Mbps) supporting PoE/PoE+ (802.3af/802.3at).
NET Ethernet RJ45 port (10/100/1000Mbps) to your router or another GWN7610 series
*%* USB 2.0 port (for future IOT & location based applications)

RESET Factory reset button. Press for 7 seconds to reset factory default settings.
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Power and Connect GWN7610 Access Point

Step 1:

Connect one end of a RJ-45 Ethernet cable into the NET or POE/NET port of the GWN7610.

Step 2:

Connect the other end of the Ethernet cable(s) into a LAN port to your Network.

Step 3:

Connect the 24V DC power adapter into the power jack on the back of the GWN7610. Insert the main plug

of the power adapter into a surge-protected power outlet.

Notes:
e GWN7610 can be powered using PoE(802.3af)/PoE+(802.3at) switch via POE/NET port. In this
scenario, GWN7610 should be connected to the Router using NET port.
o GWN7610 has a PoE detection daemon that will monitor the status and update maximum
allowable power for USB ports in real time.
Step 4:

Wait for the GWN7610 to boot up and acquire an IP address from the DHCP Server.

Figure 2: Connecting GWN7610

Warranty

If the GWN7610 Wireless Access Point was purchased from a reseller, please contact the company where
the device was purchased for replacement, repair or refund. If the device was purchased directly from
Grandstream, contact our Technical Support Team for a RMA (Return Materials Authorization) number
before the product is returned. Grandstream reserves the right to remedy warranty policy without prior

notification.
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Wall and Ceiling Mount Installation

GWN7610 can be mounted on the wall or ceiling, please refer to the following steps for the appropriate
installation.

Wall Mount

Step1:

Position the mounting bracket at the desired location on the wall with

the arrow pointing up.

Step 2:

Figure 3: Wall Mount — Steps 1 & 2

wall

Use a pencil to mark the four mounting holes (screw holes DIA5.5mm,
reticle hole DIA 25mm).

Step 3:

Insert screw anchors into the 5.5 mm holes. Attach the mounting

bracket to the wall by inserting the screws into the anchors.

Plastic Expansion | | |
Bait |

Step 4:

Connect the power cable and the Ethernet cable (RJ45) to the correct
ports of your GWN7610.

Step 5:

Align the arrow on the GWN7610AP with the arrow on the locking tab

of the mounting bracket and ensure that your GWN is firmly seated on
the mounting bracket.

Step 6:

Turn the GWN clockwise until it locks into place and fits the locking
tab.

Figure 5: Wall Mount — Steps 5 & 6
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Ceiling Mount

Step 1:

Remove the ceiling tile.

Step 2:

Place the ceiling backing plate in the center of the ceiling tile and mark
the mounting screw holes (screw holes DIA 5.5mm, reticle hole DIA
25mm).

Step 3:

Insert the screws through the mounting bracket.

Step 4:

Connect the power cable and the Ethernet cable (RJ45) to the correct
ports of your GWN7610.

Step 5:

Align the arrow on the GWN7610AP with the arrow on the locking tab
of the mounting bracket and ensure that your GWN is firmly seated on

the mounting bracket and connect the network and power cables.

Step 6:

Turn the GWN clockwise until it locks into place and fits the locking
tab.

A Note:

Ceiling mounting is recommended for optimal coverage performance.

GWN7610 User Manual
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M3.0x50 screw

Figure 7: Ceiling Mount — Step 3

Figure 8: Ceiling Mount — Step 4

Figure 9: Ceiling Mount — Steps 5 & 6
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GETTING STARTED

The GWN7610 Wireless Access Point provides an intuitive Web GUI configuration interface for easy
management to give users access to all the configurations and options for the GWN7610’s setup.

This section provides step-by-step instructions on how to read LED patterns, discover the GWN7610 and
use its Web GUI interface.

LED Patterns

The panel of the GWN7610 has different LED patterns for different activities, to help users read the status
of the GWN7610 whether it's powered up correctly, provisioned, in upgrading process and more, for more

details please refer to the below table.
Table 4: LED Patterns

I L

OFF Unit is powered off or abnormal power supply.
Solid green Unit is powered on.

Blinking green Firmware update in progress.

Solid green Firmware update successful.

Solid red Firmware update failed.

Blinking purple  Unit not provisioned.

Blinking blue Unit provisioning in progress.

Solid blue Unit is provisioned successfully.
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Discover the GWN7610

Once the GWN7610 is powered up and connected to the Network correctly, users can discover the
GWN7610 using one of the below methods:

Method 1: Discover the GWN7610 using its MAC address

1. Locate the MAC address on the MAC tag of the unit, which is on the underside of the device, or on
the package.
2. From a computer connected to same Network as the GWN7610, type in the following address using
the GWN7610’s MAC address on your browser.
For example, if a GWN7610 has the MAC address 00:0B:82:8B:4E:28, this unit can be accessed by typing
https://gwn_000b828b4e28.local/ on the browser.

B cwn7610 X |+

— O Ihttps://gwn_ooobs23b4ezs.|oca|/ I

GRANDSTREAM

CONNECTING THE WORLD

GWN7/610

Figure 10: Discover the GWN7610 using its MAC Address

Method 2: Discover the GWN7610 using GWNDiscoveryTool

1. Download and install GWNDiscoveryTool from the following link:

http://www.grandstream.com/sites/default/files/Resources/GWNDiscoveryTool.zip

2. Open the GWNDiscoveryTool, click on Select to define the network interface, then click on Scan.
3. The tool will discover all GWN7610 Access Points connected on the network showing their MAC,
IP addresses and firmware version.

GWN7610 User Manual
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4. Click on Manage Device to be redirected directly to the GWN7610's configuration interface, or type
in manually the displayed IP address on your browser.

5| GWNDiscoveryTool | = = |
Help
Discovered Devices Total count : 5
gwn7510 - Slave Version :  1.0.3.21 i

Manage Device
MAC: 00:0b:82:8b:4e:28 IPv4: 192.168.6.54

gwn7610 - Slave Veersion : 1.0.3.21

Manage Device
MAC: 00:0b:82:8b:4d:d4 IPv4 @ 192.168.6.20

gwn7610 - Master Version : 1.0.4.20
Manage Device

m

MAC: 00:0b:82:8b:4d:d8 IPv4 . 192.168.6.27

gwn/e00 - Master Version : 1.0.3.19

Manage Device
MAC: 00:0b:82:8b:58:30 IPv4 @ 192.168.6.179

4 (LI 2

‘ select ‘ ‘ Scan ‘ ‘ Clear

Figure 11: GWN Discovery Tool
Users can access then the GWN7610 using its Web GUI, the following sections will explain how to access

and use the Web Interface.
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Use the Web GUI

Access Web GUI

The GWN7610 embedded Web server responds to HTTPS GET/POST requests. Embedded HTML pages
allow users to configure the device through a Web browser such as Microsoft IE, Mozilla Firefox, Google
Chrome etc.

English v

GWN7610

Figure 12: GWN7610 Web GUI Login Page
To access the Web GUI:

1. Make sure to use a computer connected to the same local network as the GWN7610.
2. Ensure the device is properly powered up.

3. Open a Web browser on the computer and type in the URL using the MAC address as shown in
Discover the GWN7610 or the IP address using the following format:

https://IP_Address

4. Enter the administrator’s login and password to access the Web Configuration Menu. The default
administrator's username and password are "admin" and "admin".

Note: At first boot or after factory reset, users will be asked to change the default administrator password
before accessing GWN7610 Web interface.

The new password field is case sensitive with a maximum length of 32 characters. Using strong password
including letters, digits and special characters is recommended for better security.
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Change Password

New Password

Confirm New Password

Figure 13: Change Password on first boot

Web GUI Languages

Currently the GWN7610 series Web GUI supports English and Simplified Chinese.
Users can select the displayed language at the upper right of the Web GUI either before or after logging in.

GRANDSTREAM

CONNECTING THE WORLD

English

GWN7610

Figure 14: GWN7610 Web GUI Language - Login page
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& GWN7610 rrmware 10420 English v admin [

Clients AP Channel Distribution
Overview

Figure 15: GWN7610 Web GUI Language

Overview Page

Overview is the first page shown after successful login to the GWN7610’s Web Interface. Overview page
provides an overall view of the GWN7610’s information presented in a Dashboard style for easy monitoring.

S GWN7610 Fmware1.0.4.20 ® o] 155 W English w admin [»

AP Clients AP Channel Distribution
Overview
B Discoverad 2
Wz4c 1] 24G =
@ Cnline 1 O 1 2 3 4 5 6 7 8 9 10 11 12 13 14
Total BsG o
Offline 1} .
5G -
R P & @ @ PP PRI LD R, 0,0, P
Top AP Last 1 day - Top SSID  Last 1 day -
No. Mame/MAC Type Clients  Usage~ Mo.  Mame Clients Usage~
There are no APs. There are no SSIDs.

Top Clients Al - Alert/Notification
No.  Mame MAC Address Download = Upload ) Critical

-
1 50:F0:D3:E5:85:E2 15.89MB 1.77MB B Uil O T
2 48:4B:AA:08:3F:90 7218 4778 Major

‘ 0 Unread / 0 Total
3 CB:38:70:3C:11:A6 206B 3468
4 F4:B7:E2:BF:C9:D2 2068 3188 o Normal

1 Unread / 1 Total

Figure 16: Overview Page

Users can quickly see the status of the GWN7610 for different items, please refer to the following table for
each item:
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Table 5: Overview
Shows the number of Access Points that are Discovered,
AP Paired(Online) and Offline. Users may click on to go to Access
Points page for basic and advanced configuration options for the APs
Shows the total number of connected clients, and a count for clients
Clients connected to each Channel. Users may click on to go to Clients
page for more options.
Shows the Channel used for all APs that are paired with this Access

Point.

AP Channel Distribution

Shows the Top APs list, users may assort the list by number of clients
Top AP connected to each AP or data usage combining upload and download.

Users may click on to go to Access Points page for basic and

advanced configuration options for the APs.

Shows the Top SSIDs list, users may assort the list by number of clients
Top SSID connected to each SSID or data usage combining upload and download.

Users may click on to go to Network Group page for more options.

Shows the Top Clients list, users may assort the list of clients by their
Top Clients upload or download. Users may click on to go to Clients page for

more options.

Shows 3 types of Alert/Notifications: Critical, Major and Normal. Users
Alert/Notification
can click to pop up the list of Alert and Notifications.

Note that Overview page in addition to other tabs can be updated each 15s, 1min ,2min and 5min or Never

by clicking n in the upper bar menu (Default is 15s).

Save and Apply Changes

When clicking on "Save" button after configuring or changing any option on the Web GUI pages. A message
mentioning the number of changes will appear on the upper menu.

s GWN7610 Firmware1.0.4.20 You have 10 changes not applied. Apply | Revert | v | English w admin [>

Figure 17: Apply Changes

R

Click on button to apply changes, or |"7"'t| to undo the changes.
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USING GWN7610 AS STANDALONE ACCESS POINT

The GWN7610 can be used in Standalone mode, where it can act as Master Access Point Controller or in
Slave mode and managed by another GWN7610 Master.

This section will describe how to use and configure the GWN7610 in standalone mode.
Connect to GWN7610 Default Wi-Fi Network

GWN7610 can be used as standalone access point out of box, or after factory reset with Wi-Fi enabled by
default.

After powering the GWN7610 and connecting it to the network, GWN7610 will broadcast a default SSID
based on its MAC address GWN[MAC'’s last 6 digits] and a random password.

Note that GWN7610’s default SSID and password information are printed on the MAC tag of the unit as
shown on the below figure.

' Model: GWN7610
/ »w5RANDSTREAM Ingulte:DCZ4V=1A

This device complies with part 15 of the FCC rules. {l\
?ieration is subject to the following two conditions: e’ &

this device may not cause harmful interference.
(2) this device must accept any interference received,
including interference that may cause undesired operation. Ef
_——

I c €

S/N 22VOMFOE30616552

IR AR Carmplis wih CAN

MA B8261 2 ICES-3(B)/NMB(B)
Il Illlﬁl(ii)l(fllfllﬁlflslﬁ FGC IDYZZGWNT61
SSID: GWNXXXxxx FCC ID:YZZGWN7610

. WiFi Password: AA11BB22 (US)P/N 964-00006-17A001  Made in China

Figure 18: MAC Tag Label
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USING GWN7610 AS MASTER ACCESS POINT CONTROLLER

Master Mode allows a GWN7610 to act as an Access Point Controller managing other GWN7610 access
points. This will allow users adding other access points under one controller and managing them in an easy
and a centralized way.

Master/Slave mode is helpful with large installations that need more coverage area zones with the same

controller.

‘;GRANDSTREAM English v

GWN7610

Figure 19: Login Page

At factory reset, “Set unit as Master” will be checked by default, click on “Sign In” after typing the admin’s
username and password.

A Warning:

“Set unit as Master” option will forbid the GWN7610 Access Point from being paired by other Master
GWN7610, and can only act as a Master Access point controller.

Users will need to perform a factory reset to the GWN7610, or unpair it from the initial GWN7610 to make
it open to Master Access Point mode again.

Login Page
After login, users can use the Setup Wizard tool to go through the configuration setup, or exit and configure

it manually. Setup Wizard can be accessed anytime by clicking on while on the Web interface.
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Setup Wizard

The setup wizard will guide you through the basic setup of your GWN
product. If you don't wish to see this wizard again, please check the box
below. You can always access the setup wizard by selecting the gear icon

at the top right of the screen.

Click "Next" to start the setup wizard.

Next

-JDon't show me this again

Figure 20: Setup Wizard
Discover and Pair Other GWN7610 Access Point

To Pair a GWN7610 access point connected to the same Network as the GWN7610 follow the below steps:

1. Connectto the GWN7610 Web GUI as Master and go to Access Points.

s GWN7610 Frmware1.0.4.20 ® Q 155 W English w admin [»

Access Points

Access Pomts Device Type N
C;:) Upgrade G Reboot + Add to Network Groups )f Configure O

(] Device Type Name/MAC IP Address Status Uptime Firmware Actions

) GWN7610 00:0B:82:8B:4D:D8 192.168.6.27 Master 7h 4m 555 1.0.4.20 D/ 8

Showing 1-1 of 1 record(s). Per Page: 10 ¥

Figure 21:Discover AP

2. Click on discover access points within GWN7610’s Network, the following page will
appear.
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Discovered Devices X
Device Type MAC IP Address Firmware Actions
GWN7610 00:03:07:12:34:506 192.168.6.54 1.0.3.21
GWN7610 00:0B:82:8B:4D:D4 192.168.6.20 1.0.3.21

5 g 1-2 of 2 record er Page: |10 v

Figure 22: Discovered Devices

Note: Discovered Slave Aps with lower firmware than the master AP will be highlighted in red bold to remind
the users to upgrade their AP, more details refer to [Controller Protocol Security Enhancement]

3. Click on Pair under Actions, to pair the discovered Access Point as Slave with the GWN7610 acting

as Master
4. The paired GWN7610 will appear Online, users can click on to unpair it.
GWN7610 00:0B:82:8B:4D:D8 192.168.6.27 Master 7h 9m 57s 1.0.4.20
Figure 23: GWN7610 online
5. Users can click on next to Master or paired access point to check device configuration for its

status, users connected to it and configuration. Refer to below table for Device Configuration tabs.

Table 6: Device Configuration

Fea _[foescipon |

Shows the device’s status information such as Firmware version, IP

Status Address, Link Speed, Uptime, and Users count via different Radio
channels.
Clients Shows the users connected to the GWN7610 access point.

e Device Name: Set GWN7610’s name to identify it along with its
MAC address.
e Fixed IP: Used to set a static IP for the GWN7610, if checked
Configuration
users will need to set the following:
-IPv4 Address: Enter the IPv4 address to be set as static for the
device

GWN7610 User Manual
Version 1.0.4.22
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-IPv4 Subnet Mask: Enter the Subnet Mask.

-IPv4 Gateway: Enter the Network Gateway’s IPv4 Address.
-Preferred IPv4 DNS: Enter the Primary IPv4 DNS.
-Alternate IPv4 DNS: Enter the Alternate IPv4 DNS.

e Frequency: Set the GWN7610’s frequency, it can be either
2.4GHz, 5GHz or Dual-band.

e Enable Band Steering: When Frequency is set to Dual-Band,
users can check this option to enable Band Steering on the
Access Point, this will help redirecting clients to a radio band
accordingly for efficient use and to benefit from the maximum
throughput supported by the client.

e Mode(2.4G): Choose the mode for the frequency band,
802.11n/g/b for 2.4GHz and 802.11ac for 5GHz.

e Channel Width: Choose the Channel Width, note that wide
channel will give better speed/throughput, and narrow channel will
have less interference. 20MHz is suggested in very high density
environment.

e 40MHz Channel Location: Configure the 40MHz channel
location when using 20MHz/40MHz in Channel Width, users can
set it to be “Secondary Below Primary”, “Primary Below
Secondary” or “Auto”.

e Channel: Select “Auto” or a specific channel. Default is “Auto”.
Note that the proposed channels depend on Country Settings
under System Settings—>Maintenance.

e Enable Short Guard Interval: Check to activate this option to
increase throughput.

o Active Spatial Streams: Choose active spatial stream. Available
options: “Auto”, “1 stream”, “2 streams” and “3 streams”.

e Radio Power: Set the Radio Power depending on desired cell
size to be broadcasted, three options are available: “Low”,
“Medium” or “High”. Default is “High”.

e Allow Legacy Device(802.11b): This feature appears when
“‘Mode” option is set to “802.11g” or “802.11n”, it allows legacy
devices not supporting “802.11g/n” mode to connect using the
“802.11b” mode.
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e Custom Wireless Power(dBm): allows users to set a custom
wireless power for both 5GHz/2.4GHz band, the value of this field

must be between 1 and 31.

Note:

If a GWN7610 is not being paired or the pair icon is grey color, make sure that it is not being paired with
another GWN7610 Access Point acting as Master Controller, if yes, users will need to unpair it first, or reset
it to factory default settings to make it available for pairing by other GWN7610 Access Point Controller.

Locate Other Access Points by Blinking LED

GWN supports a handy feature which allows users to locate other Access points by blinking LED. To use

the feature, navigate on the master web GUI under “Access Points” page and click on the icon 2 near

the desired AP, and it corresponding unit will start blinking the LEDs.
Failover Master

In a Master-Slave architecture, having a backup Master is critical for redundancy and failover function, thus,
and in order to avoid a single point of failure in your wireless network, you can specify a slave AP as failover
master. Whenever it detects the master is down, it will promote itself as failover master within a time frame
of around 20~30 minutes by entering failover mode. After then, if the master AP comes back, failover master
will automatically go back to slave mode, or if the master doesn’t come back to alive, Administrator can
login using “failover” account to turn the failover master as true master and take over all controls.

Network Group 1

GWN7610s Slaves

PoE/PoE+ Switch S >>>

Router

Backup Master

GWN7610 GWN7610s
g

Master

—O )

GWN7610s Slaves

Network Group 2

Figure 24: Failover Master

Users could select the failover Master by following below steps:

GWN7610 User Manual
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e Log into web GUI of the master GWN.

e Go to Access Points page.

e Press

e Select from the available paired Slave Aps the candidate to become a failover Master.

e Save and Apply the settings.
Failover Mode

Once failover slave has been selected, the primary master will send the configuration of the network to the
failover slave and the slave will start monitoring the status of the primary master to detect any failure for
any reason (network connection loss, power outage).

In case of failure, the failover slave will promote itself to a temporary backup master while waiting for the
primary master to come back.

During the failover mode users could access the web GUI of the failover slave using a special failover
account with same admin password.

¢ Username = failover

¢ Password = admin password

Figure 25: Failover Mode GUI

The failover mode has only read permission on the configuration and very limited options, users still can
reboot other slave Access points in case it is needed.

Users also can press on « Switch to master » button in order to set the failover slave as the new primary
master of the wireless network, once this is done they have full write permission control over the web GUI
option as usual.

Controller Protocol Security Enhancement

Controller protocol security enhancement is important for secured provision from Master to Slave. So once
a master with 1.0.2.108 found a slave with an older firmware, it will disable the slave’s Wi-Fi and show the
slave’s firmware version in RED BOLD to remind user to upgrade the slave as shown on figure below.
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S GWN7/7610 Firmware1.0.4.20 ® Q 155 w English w admin [

Access Points

& Upgrade Q Reboot + Add to Network Groups m 0

Device Type Name/MAC IP Address Status Uptime Firmware Actions
rd GWN7610 00:08:82:8B:4D:D8 192.168.6.27 Master 7h 32m 12s 1.0.4.20 4 2
GWN7610 00:0B:82:8B:4E:28 192.168.6.37 Online 7d 6h 38m 195 1.0.3.21 M 2% 2
Showing 1-2 of 2 record(s). Per Page: (10 ¥

Figure 26: Controller Protocol Security Enhancement

Client Bridge

The Client Bridge feature allows an access point to be configured as a client for bridging wired only clients
wirelessly to the network. When an access point is configured in this way, it will share the WiFi connection
to the LAN ports transparently. This is not to be confused with a mesh setup. The client will not accept
wireless clients in this mode.

Once a Network Group has an Client Bridge Support enabled, the AP adopted in this Network Group can

be turned in to Bridge Client mode by click the Bridge button %.

Please be noted that once an AP it turned into Client Bridge mode, it cannot be controlled by a Master
anymore, and a factory reset is required to turn it back into normal AP mode.

GWN7610 00:0B:82:8B:4E:28 192.168.6.37 online 1.0.3.21 £ 2% &

Figure 27: Client Bridge
Important Notes:
e The access point that will be operating on bridge mode, must be set with a fixed IP address before
activating the bridge mode on the access point.
e Users must enable client bridge support option under network group or SSID WiFi settings in order
to have it fully functional. See [Client Bridge Support]
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NETWORK GROUPS

When using GWN7610 as Master Access Point, users can create different Network groups and adding
GWN7610 Slave Access Points.

Log in as Master to the GWN7610 WebGUI and go to Network Group—->Network Group.

s GWN7610 Firmware1.0.4.20 @ Q 155 W English w admin [+

Name Enabled SsID Enable Wi-Fi VLAN ID IP Address Actions

group0 [V GWNSB4DDS v 4

Network Group

Figure 28: Network Group

2
The GWN7610 will have a default network group named group0, click on L to edit it, or click on

to add a new network group.

Add p 4
Basic Wi-Fi Device Membership Schedule
Network Group Mame (2) | Testing_Group

Enabled [
VILAN o]
VLAN ID 2

Enable IPv4 (2) [

Figure 29: Add a New Network Group

When editing or adding a new network group, users will have three tabs to configure:
e Basic: Used to name the network group, and set a VLAN ID if adding a new network group

o  Wi-Fi: Please refer to the below table for Wi-Fi tab options
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Table 7: Wi-Fi
Fos  Joeserten
Enable Wi-Fi Check to enable Wi-Fi for the network group.
SSID Set or modify the SSID name.
Select the Wi-Fi band the GWN will use, three options are available:
Dual-Band
SSID Band ¢ TuaEan
e 24GHz
e 5Ghz
Select to hide SSID. SSID will not be visible when scanning for Wi-Fi, to
SSID Hidden connect a device to hidden SSID, users need to specify SSID name and

authentication password manually.

Configure the limit for wireless client. If there’s an SSID per-radio on a

. . L. network group, each SSID will have the same limit. So, setting a limit of 50
Wireless Client Limit o )
will limit each SSID to 50 users independently.

If set to 0 the limit is disabled.

Enable Captive Portal Click on the checkbox to enable the captive portal feature.

Select the captive portal policy already created on the “CAPTIVE

Captive Portal Polic
s J PORTAL” web page to be used in the created SSID.

Set the security mode for encryption, 5 options are available:
e WEP 64-bit: Using a static WEP key. The characters can only be
0-9 or A-F with a length of 10, or printable ASCII characters with a
length of 5.

e WEP 128-bit: Using a static WEP key. The characters can only be
0-9 or A-F with a length of 26, or printable ASCII characters with a

Security Mode length of 13.
e WPA/WPA2: Using “PSK” or “802.1x” as WPA Key Mode, with
“AES” or “AES/TKIP” Encryption Type.
e WPA2: Using “PSK” or “802.1x” as WPA Key Mode, with “AES” or
“AES/TKIP” Encryption Type. Recommended configuration for
authentication.
e Open: No password is required. Users will be connected without
authentication. Not recommended for security reasons.
WEP Key Enter the password key for WEP protection mode.
WPA Key Mode Select key mode (Pre-Shared Key or 802.1X Authentication).
WPA Encryption Type Select Encryption type (AES or AES/TKIP).
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WPA Pre-Shared Key

Client Bridge Support

RADIUS Sever Address
RADIUS Server Port
RADIUS Server Secret

RADIUS Accounting Server
Address

RADIUS Accounting Server
Port

RADIUS Accounting Server

Secret

RADIUS NAS ID

Client Time Policy

Use MAC Filtering

Enable Dynamic VLAN

Client Isolation
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Configures the WPA pre-shared key. The input range: 8-63 ASCII

characters or 8-64 hex characters.

Configures the client bridge support to allows the access point to be
configured as a client for bridging wired only clients wirelessly to the
network. When an access point is configured in this way, it will share the
WiFi connection to the LAN ports transparently. Once a Network Group
has an Client Bridge Support enabled, the AP adopted in this Network
Group can be turned in to Bridge Client mode by click the Bridge button.

Configures RADIUS authentication server address.
Configures RADIUS Server Listening port (defaults to 1812).
Enter the secret password for client authentication with RADIUS server.

Configures the address for the RADIUS accounting server.

Configures RADIUS accounting server listening port (Default is 1813).

Enter the secret password for client authentication with RADIUS
accounting server.

Configures the Radius NAS ID used to notify the source of RADIUS access
request so that, the RADIUS server can choose policy for that request.

Configures the client time policy. Default is None.

Choose Blacklist/Whitelist to specify MAC addresses to be
excluded/included from connecting to the zone’s WiFi. Default is Disabled.

When enabled, clients will be assigned IP address form corresponding
VLAN configured on the Radius user profile.

Client isolation feature blocks any TCP/IP connection between connected
clients to GWN7610’s Wi-Fi access point. Client isolation can be helpful to

increase security for Guest networks/Public WiFi. The available modes are:

¢ Internet Mode: Wireless clients will be allowed to access only the
internet services and they cannot access any of the management

services, either on the router nor the access points GWN7610.

e Gateway MAC Mode: Wireless clients can only communicate
with the gateway, the communication between clients is blocked
and they cannot access any of the management services on the
GWN7610 access points.
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e Radio Mode: Wireless clients can access to the internet services,
GWNT7xxx router and the access points GWN7610 but they cannot

communicate with each other.

This field is required when using Client Isolation, so users will not lose

access to the Network (usually Internet).

Gateway MAC Address Type in the default LAN Gateway’s MAC address (router’s MAC address
for instance) in hexadecimal separated by “”.
Example: 00:0B:82:8B:4D:D8

Check to enable RSSI function, this will lead the AP to disconnect users

RSSI Enabled : Copn

below the configured threshold in Minimum RSSI (dBm).

Enter the minimum RSSI value in dBm. If the signal value is lower than the
Minimum RSSI (dBm) configured minimum value, the client will be disconnected. The input range

is from “-94” or “-1”.
Enable this feature to help clients connected to the GWN7610 to perform
better roaming decision.

e The 802.11k standard helps clients to speed up the search for
nearby APs that are available as roaming targets by creating an
optimized list of channels. When the signal strength of the current
AP weakens, your device will scan for target APs from this list.

e When your client device roams from one AP to another on the
. . same network, 802.11r uses a feature called Fast Basic Service
Enable Voice Enterprise » . . )
Set Transition (FT) to authenticate more quickly. FT works with
both pre-shared key (PSK) and 802.1X authentication methods.
e 802.11v allows client devices to exchange information about the
network topology, including information about the RF
environment, making each client network aware, facilitating

overall improvement of the wireless network.

Note: 11R is required for enterprise audio feature, 11V and 11K are

optional.
Enable 11R Check to enable 802.11r
Enable 11K Check to enable 802.11k
Enable 11V Check to enable 802.11v
Upstream Rate Set a limitation of upload speed on the SSID.
Downstream Rate Set a limitation of download speed on the SSID.
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o Device Membership: Used to add or remove paired access points to the network group.

Add p 4
Basic Wi-Fi Device Membership Schedule
Available Devices Member Devices
00:0B:82:A4:14:BC - 00:0B:82:8B:4E:24 -
=)
=
- w

Figure 30: Device Membership
Click on = to add the GWN7610 to the network group, or click on * toremove it.

e Schedule: Used to schedule the times when the Wi-Fi is ON or OFF.

In the example below the Wi-Fi is scheduled to be active Monday starting from 8:00 AM until 5:00 PM.

Note: The hour field is in 24 format (from 0 to 23). Valid range for minutes is 0-59.
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Add X

Basic Wi-Fi Device Membership w

Enable Wireless Schedule )
Sunday J
Monday [+
Schedule Start Time 8 0
Schedule End Time 17 0
Tuesday J
Wednesday O
Thursday J
Friday J

Saturday O

Save ‘ Cancel

Figure 31: Wi-Fi Schedule

Note:
The schedule feature is based on SSID and not network group, meaning that you can schedule the
broadcasting of different SSID on different periods of the day.
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Users can Also add a device to a Network Group from Access Points Page:

- Select the desired AP to add to a Network Group and click on .

Add to Network Groups

Note: If the selacted AF has bean sdded to other network groups, this ssttin
original oparation.

All

[1Group0

[ Testing_Group

Figure 32: Add AP to Network Group from Access Points Page

- Check to select the desired Network, on which the selected APs will be added, as shown in the above
figure.

Create an SSID under a Network Group

Under Network Group Page, click to edit a network group or create a new network group and go to Wi-Fi
tab.
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Basic

Enable Wi-Fi
ssID (2)
SSID Band
SSID Hidden
Wireless Client Limit (2)
Enable Captive Portal
Security Mode
WPA Key Mode
WPA Encryption Type
WPA Pre-Shared Key (2)
Client Bridge Support
Client Time Policy

Use MAC Filtering

Edit

Device Membership

]

LAB

Dual-Band

WPAZ

PSK

AES

Mone

Disabled

Save | Cancel

Schedule

Refer to [Table 7: Wi-Fi] for Wi-Fi options.

Figure 33: Create an SSID

Additional SSID under Same Network Group

Users can also create an additional SSID under the same group. To create an additional SSID go to
Network Group->Additional SSID.

D
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Add X

Wi-Fi Schedule

Enable Additional SS5ID |«

ssID (7) | Additionam_SSID

SSID Band Dual-Band v
Network Group Membership group0 v
SSID Hidden J

Wireless Client Limit (2) | 50

Enable Captive Portal 0

Security Mode WpPAZ v
WPA Key Mode PSK v
WPA Encryption Type AES v
WPA Pre-Shared Key (2) ssssssssse 'O 3

Client Bridge Support 0J

Client Time Policy None v

Save | Cancel

Figure 34: Additional SSID

Select one of the available network groups from Network Group Membership dropdown menu, this will
create an additional SSID with the same Device Membership configured when creating the main network

group.

SSID Enabled Network Group Hidden Security Mode MAC Filtering Client Isolati... RSSI Actions

Additional_SSID v group0 X WPA2 Disabled x x m 1

Figure 35: Additional SSID Created

Click on to delete the additional SSID, or Df to edit it.
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CLIENTS CONFIGURATION

Users can configure clients’ parameters, time policy and also check the list of the clients that has been
banned after time disconnect policy has been enabled. Below we discuss each section of this menu:

Clients

Users can access clients list connected to GWN7610 from Web GUI->Clients>Clients to perform different
actions to wireless clients.

; GWN7610 Fimware1.0.4.20 ©) o} 155 W English admin [>

Online : 1
All Network Groups ¥ All Radios v
Total : 1
MAC Hostname  Type IP Address Radio/ChanneStatus Bridge AP Throughput Aggregate Actions
5GHz anline TX:0B/s TX:1.23KB _
48:4B:AA:08:3F:90 Wireless b4 00:0B:82:8B:4D:... & *5
149 00:00:02 RX:0B/s RX:320B
Showing 1-1 of 1 record(s). Per Page: |10 ¥
Clients
Figure 36: Clients
L’?\
e Clickon under Actions to check client’s status and modify basic settings such Device’s Name.
(s

e Clickon = toblock a client's MAC address from connecting to the zone's network group.

Clients Access

From this menu, users can manage in global and way the blacklist of clients that will be blocked from

Client Access

accessing the WiFi network, click on to add or remove MAC addresses of client from

global blacklist.

Name MAC Addresses Actions

Global Blacklist (2) 48:4B:AA:08:3F:92, 48:4B:AA:08:3F:90 r_lf

Figure 37: Global Blacklist
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Edit
MName Global Blacklist
MAC Addresses 48:4B:AA:08:3F:92 e
48:4B:AA:08:3F:90 (]
Add new item c

Figure 38: Managing the Global Blacklist

A second option, is to add custom access lists that will be used as matching mechanism for MAC address
filtering option under network groups and SSIDs to allow (whitelist) or disallow (blacklist) clients access to
the WiFi network.

Click on in order to create new access list, then fill it with all MAC addresses to be matched.

Once this is done, this access list can be used under network group or SSID WiFi settings to filter clients
either using whitelist or blacklist mode.

Eart
Basic m Device Membership Schedule
SSID Hidden
wireless Client Limit (2
Enable Captive Portal
Security Mode Open v

Client Bridge Support

Client Time Policy Sminute v
Use MAC Filtering Blacklist v
MAC Blacklist ¥ ACL1

Figure 39: Blacklist Access List

Time Policy

The timed client disconnect feature allows the system administrator to set a fixed time for which clients
should be allowed to connect to the access point, after which the client will no longer be allowed to connect
for a user configurable cool-down period.

The configuration is based on a policy where the administrator can set the amount of time for which clients
are allowed to connect to the WiFi and reconnect type and value after which they will be allowed to connect
back after they have been disconnected.

In order to create a new policy, go under Clients>Time Policy and add new one., then the following
parameters:

GWN7610 User Manual
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Table 8: Time Policy Parameters

Name Enter the name of the policy
Enabled Check the box to enable the policy
Limit Client Connection Time Sets amount of time a client may be connected.

Select the method with which we will reset a client’s connection timer
so they may reconnect again. Options are:
. . o Reset Daily.
Client Reconnect Timeout Type
o Reset Weekly.
e Reset Hourly.

e Timed Reset.

. . If ‘Timed Reset’ is selected, this is the period for which the client will
Client Reconnect Timeout i ,
have to wait before reconnecting.

Reset Day If Reset Weekly is selected, this is the day the reset will be applied.

If Reset Weekly or Reset Daily is select, this is the hour and day the
Reset Hour . .
reset will be applied.

Note: Time tracking shall be accounted for on a per-policy basis, such that a client connected to any SSID
assigned the time tracking policy will accrue a common counter, regardless of which SSID they are
connected to (as long as those SSIDs all share the same time tracking policy).

Banned Clients

Click on e to view the list of the clients that have been banned after time disconnect

feature has taken effect, these clients will not be allowed to connect back until timeout reset or you can
unblock a client by clicking on the icon

Banned Clients

MAC Addresses Time Policy Release Time Actions
A0:CB:FD:F4:DF:FE Sminute 2017-08-24 11:40:00
30:75:12:FF:37:89 Sminute 2017-08-24 11:40:00
DC:09:4C:A4:38:BE Sminute 2017-08-24 11:41:00

Figure 40: Ban/Unban Client
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LED SCHEDULE

GWN7610 Access Points series support also the LED schedule feature. This feature is used to set the
timing when the LEDs are ON and when they will go OFF at customer’s convenience.

This can be useful for example when the LEDs become disturbing during some periods of the day, this way
with the LED scheduler, you can set the timing so that the LEDs are off at night after specific hours and

maintain the Wi-Fi service for other clients without shutting down the AP.

To configure LED schedule, on the GWN7610 WebGUI navigate to “System Settings - LEDs”.

Following options are available:

Table 9: LED Schedule settings

LEDs Always off Turn off completely the LEDs.

Schedule Start Hour Configure the hour when LEDs will be automatically turned on.
Schedule Start Minute Configure the minute when LEDs will be automatically turned on.
Schedule Stop Hour Configure the hour when LEDs will be automatically turned off.
Schedule Stop Minute Configure the minute when LEDs will be automatically turned off.
Schedule weekdays list Choose the days for which you want to schedule the LEDs.

Following example sets the LEDs to be turned on from 8am till 8pm every day.
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s GWN7610 rFirmware1.0.4.20 ® Q 155 w English w admin [

LEDs
Overview
LEDs Always Off (2) @
Schedule Start Hour (2) | 8
Schedule Start Minute (2) 0
Schedule Stop Hour (2) 20
Schedule Stop Minute (2) 0

Schedule Weekdays List of Weekdays “ m

« Sunday

« Monday

¥ Tuesday

# Wednesday
« Thursday
« Friday

« Saturday

Save | <

o

Figure 41: LEDs Schedule
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CAPTIVE PORTAL

Captive Portal feature on GWN7610 AP helps to define a Landing Page (Web page) that will be displayed
on Wi-Fi clients’ browsers when attempting to access Internet. Once connected to a GWN7610 AP, Wi-Fi
clients will be forced to view and interact with that landing page before Internet access is granted.

The Captive Portal feature can be configured from the GWN7610 Web page under “Captive Portal”.

The page contains three tabs: Policy, Files and Clients.

Policy Configuration Page

The policy configuration page contains options for authentication type used when enabling the captive portal
feature. The following table describes all the settings on this page:

Table 10: Basic Configuration Page

Foa Josseipon

Name Enter a name to identify the created landing page.

Enter the expiration time for the landing page, this field must contain
Expiration an integer between 60 or 604800 in minutes.

If this field is set to 0 the landing page will never expire.

Three types of authentication are available:
e No Authentication: when choosing this option, the landing
page feature will not provide any type of authentication,
instead it will prompt users to accept the license agreement

to gain access to internet.
Authentication Type

e RADIUS Server: Choosing this option will allow users to set

a RADIUS server to authenticate connecting clients.

¢ WeChat: Choosing this option will allow users to log in using
WeChat app.

Enter the IP address or the FQDN of the RADIUS server used to
RADIUS Server Address
authenticate clients.

RADIUS Server Port Enter the RADIUS server port, by default value is 1812.

RADIUS Server Secret Enter the shared key between authenticator and RADIUS server.
Shopld Enter the Shopld for WeChat.

Appld Enter the Appld for WeChat.

SecretKey Enter the SecretKey for WeChat authentication.

Page | 50

GWN7610 User Manual
A Version 1.0.4.22




w CRANDSTREAM

CONNECTING THE WORLD

This option allows users to choose the customizable landing page
that will be shown once a client tries to connect to the GWN, two
pages are available:
o Portal Default: This page is used when no authentication is
Portal Page Customization specified, users will have only to accept license agreement

to gain access to internet.

o Portal Pass: This option provides authentication textbox
when using RADIUS authentication mode, in order to enter

username and identity stored in RADIUS database.

Note:

Users could create multiple captive portal instances and assign the desired one for each network Group.
As an example, users can create one captive portal for Intranet usage and a second one for public Guest
users, after customizing each captive portal separately, you can assign each one to the corresponding
network group.

WeChat Authentication

WeChat authentication is a solution for free business WiFi connection, this is mainly designed to help
enterprises create personalized captive portal for marketing purposes.

With a rich commercial value, it can greatly help businesses provide better customer experience for free
WiFi usage.
You can use WeChat authentication in any scenario, but considering that users use social media

For example, once a visiting customer to the coffee shop wants to access the Internet, they can scan and
select the SSID for the shop WiFi, which will pop-up the portal for authentication.

Files Configuration Page

Files configuration page allows users to view and upload HTML pages and related files (images...).

The captive portal uses two HTML pages using authentication scenarios, either portal_default.html which
doesn’'t provide authentication, only accepting license agreement, while portal_pass.html provides
textboxes for authentication, Wired or Wi-Fi clients will be redirected to one of these pages before accessing
Internet. The following figure shows portal_default.html page:
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3O ZF 0 ED 1221 PM

&

Enter

@ Accept the license agreement

< = O (2]

Figure 42: portal_default.html page

The following figure shows portal_pass.html page:

® 2"l @D 11:53 AM

Q C

userlogin

Enter

@ Accept the license agreement

< = 0 ]

Figure 43: portal_pass.html page
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The following figure shows default files used for Captive Portal:

s GWN7610 rrmware 1.0.4.20 ® Q 155 English w admin [»

Captive Portal
Policy Files Clients
Select folder : A4
Name Type Path Actions
Captive Portal images Folder J/images ﬁ]_
logo.png File fimages/logo.png D/Tn—
favicon.ico File ffavicon.ico r_l/fﬁ
portal_default.html File /portal_default.html I—_I/fﬁ
portal_pass.html File /portal_pass.html r_,/ﬁ]_

Figure 44: Files Settings Page

e Click @ to upload a new Web page.

Add Folde
e Click to add a new folder.

e Click to upload files to the selected folder.

Select folder : fimages v

e Folder can be selected from the dropdown list

Clients Page

Clients page lists MAC addresses of authenticated devices using captive portal.

Captive Portal

Basic Files Clients

MAC Addresses:
1c:65:9d:33:cf:65

80:57:19:3c:69:75

Figure 45: Client Web Page
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BANDWIDTH RULES

The bandwidth rule is a GWN7610 feature that allows users to limit bandwidth utilization per SSID or client
(MAC address or IP address).
This option can be configured from the GWN7610 WebGUI under “Bandwidth Rules”.

Click to add a new rule, the following table provides an explanation about different options
for bandwidth rules.
Table 11: Bandwidth Rules

I L

Choose the type of rule to be applied on bandwidth utilization from the
dropdown list, three options are available:
Type e SSID: Set a bandwidth limitation on the SSID level.
e MAC: Set a bandwidth limitation per MAC address.
o |P Address: Set a bandwidth limitation per IP address.

Select the SSID to which the limitation will be applied, this option appears

SSID i
only when SSID type is selected.
MAC Enter the MAC address of the device to which the limitation will be
applied, this option appears only when MAC type is selected.
Enter the IP address of the device to which the limitation will be applied,
IP address

this option appears only when IP Address type is selected.

Net kG Choose the network group to which belongs the device, this option is
etwork Grou
P available when choosing either MAC or IP address type.

Upstream Rate Specify the limit for the upload bandwidth using Kbps or Mbps.

Downstream Rate Specify the limit for the download bandwidth using Kbps or Mbps.

The following figure shows an example of MAC address rule limitation.
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Add p4
Type MAC ¥
MAC 00:0b:82:15:af:19
Metwork Group groupd r
Upstream Rate 10 Mbps
Downstream Rate 75 Mbps ¥
=l -

Figure 46: MAC Address Bandwidth rule

The following figure shows examples of bandwidth rules:

+  Add
Type SSID/MAC/IP Address Network Group Upstream Rate Downstream Rate Actions
SSID GWN 500Kbps 12Mbps (A}
MAC 00:0B:82:15:AF:19 group0 10Mbps 75Mbps ¥ m
IP Address 192.168.1.155 group0 100Kbps 100Kbps ]
Figure 47: Bandwidth Rules
Note:

The same settings for bandwidth management are available from the following menus:

Per-SSID
Navigate on the web GUI under “Network Group->Add /Edit>WiFi” and you can set the Upstream and
Downstream rate in Mbps.

Per-Client
Navigate on the web GUI under “Clients> Edit>Bandwidth Rules” where you can set the Upstream and
Downstream rate in Mbps
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SYSTEM SETTINGS

Maintenance

Refer to the following tables for Maintenance page options.

Basic

Basic page allows Country and Time configuration.
Table 12: Basic

Fied |Descrpton
Web HTTP Access Enable the web HTTP Access. By default, it’s disabled.
Web HTTPS Port Specifies the HTTPS port. By default is 443.

Select the country from the drop-down list. This can affect the number of

Country .
channels depending on the country standards.
Time Zone Configure time zone for GWN7610. Please reboot the device to take effect.
Configure the IP address or URL of the NTP server, the device will obtain
NTP Server

the date and time from the configured server.

Change the Date Display Format, three options are possible

Date Display Format
YYYY/MM/DD, MM/DD/YYYY and DD/MM/YYYY

Upgrade
The Upgrade Web page allows upgrade related configuration.

Table 13: Upgrade

I I

Authenticate Config File  Authenticate configuration file before acceptance. Default is disabled.

Enter the password for encrypting the XML configuration file using

XML Config File . , s
OpenSSL. The password is used to decrypt the XML configuration file if it

Password ) ]
is encrypted via OpenSSL.
. Specify uploading method for firmware and configuration. 3 options are
Upgrade Via i
available: HTTP, HTTPS and TFTP.
Firmware Server Configure the IP address or URL for the firmware upgrade server.
Config Server Configure the IP address or URL for the configuration file server.

Check/Download New ) ) S

. Choose whether to enable or disable automatic upgrade and provisioning
Firmware at Boot Update .
after reboot. Default is disabled.
on Boot

Allow DHCP options 66 Configure whether to allow DHCP options 66 and 43 to override upgrade
and 43 override and provisioning settings.

Automatic Upgrade Specify the time to check for firmware upgrade.

GWN7610 User Manual
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Reboot Click on Reboot button to reboot the device
Download Configuration Click on Download to download the device’s configuration file.
Upload Configuration Click on Upload a device’s configuration file.

Click on Upgrade, to launch firmware/config file provisioning. Please make
Upgrade Now .
sure to Save and Apply changes before clicking on Upgrade.

Factory Reset Click on Reset to restore the GWN7610 to factory default settings

Access

The Access Web page provides configuration for admin and user password.

Table 14: Access

P peserption

Current Administrator o
Enter the current administrator password

Password
New Administrator Change the current password. This field is case sensitive with a maximum
Password length of 32 characters.

Confirm New . i i
. Enter the new administrator password one more time to confirm.
Administrator Password

Configure the password for user-level Web GUI access. This field is case
User Password o . .
sensitive with a maximum length of 32 characters.

User Password . .
. . Enter the new User password again to confirm.
Confirmation
Syslog
The syslog Web page provides configuration settings for syslog.

Table 15: Syslog

g Ivesorpon

Syslog Server Enter the IP address or URL of Syslog server.

Select the level of Syslog, 5 levels are available: None, Debug, Info,
Syslog Level .
Warning and Error. Please reboot the GWN7610 to take effect.

Logserver

The logserver page allows the user to configure syslog server on GWN7610 in order to save log messages
on connected external USB drive.

First connect a USB drive to the Access point, then configure the parameters and make sure to start the
server in order to collect messages from devices sending syslog to GWN. Following table gives description
for configuration parameters of GWN Logserver:
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Select the size of file to trigger rotation, if left empty, then the router will use

Logrotate File Size

Logrotate File Count

Logrotate Mode

Hours

Minutes

Hour of the day
Day of the week
Devices

Enable Logserver

only the Logrotate frequency rules to trigger rotation.

Select the Maximum number of rotates files to keep. Default is 56 files.

Choose the time rotation frequency mode (default every 3 hours).

Every X hours (0-23)

Every X Minutes (0-59).

X hour of day (0-23).

X day of week (Sunday-Saturday) + X hour of day (0-23).

Enter the number of hours period after which trigger file rotation.

Enter the number of Minutes period after which trigger file rotation.

Enter the hour of day at which trigger file rotation.

Enter Day of the week + hour of day, at which trigger file rotation.

Select the path (a USB partition) to store collected logs. Required.

Enables the logserver

After settings up the logserver and saving the settings, users need to connect a USB external storage and
press Start button in order to start collecting logs.

All log messages from all devices will be put on one single file, and the router will keep rotating and creating
new files based on the configured rotation policy.
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Maintenance

Basic Upgrade Access Syslog Logserver

Logrotate File Size 1 M

Logrotate File Count 56

Logrotate Mode Every X minutes

Minutes 3
Devices Generic STORAGE DEVICE partition0

Enable Logserver (4

= -
“ Status: Active

Syslog File List

Device Generic STORAGE DEVICE partition0 v

File Name File Size Last Modified Actions

I logserver.log 1.2 MB 08-24-2017 09:30:59 I B o

Figure 48: Logserver Web Page
Debug

GWN7610 offers many features for managing and monitoring connected clients to network groups, as well
as debugging and troubleshooting.

Capture

This section is used to generate packet trace captures from network groups interfaces which will help to
sniff packets within the network group for troubleshooting purpose or monitoring...

Users will need to plug a USB device to one of the USB ports on the backside of the GWN7610.
To access Capture page, go to Maintenance->Debug-> Capture

e Click on to start capturing on a certain device plugged to the USB port.

e Clickon to stop the capture.

e Clickon to show the captured files on a chosen device, users could check the capture

files details, click on to delete all files, click on B next to a capture file to download it

™=r
on a local folder, or click on U to delete it.
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Captured File List

File Name

capture_09-02-16_09h-03m-08s 19.76 MB 1

Device PARTITION A v

File Size File Count Last Modified Actions

09-02-2016 09:06:24

Figure 49: Capture Files

The below table will show different fields used on debug page.

Table 16: Debug

Flos ——— Jowserpton

File Name
Interface
Device
File Size

Rotate Count

Direction

Source Port
Destination Port

Source IP

Destination IP

Protocol

Core Files

Enter the name of the capture file that will be generated.

Choose a network group as Interface.

Choose a device plugged to USB port to save the capture once started.
Set a File size that the capture will not exceed (Optional field)

Set a value for rotating captures (Optional Field)

Choose if you want to get all traffic or only outgoing or incoming to the choses

interface.

Set the Source Port to filter capture traffic coming from the defined source port.
Set the Destination Port to filter capture traffic coming from the defined port.
Set the Source IP to filter capture traffic coming from the defined source IP.

Set the Destination IP to filter capture traffic coming from the defined destination
IP.

Choose ALL or a specific protocol to capture (IP, ARP, TCP, UDP, ICMP, IPv6)

The Core Files Web page displays core dumps generated when the GWN7610 crash, this is helpful for

troubleshooting purposes, if any core dump found on this page please help to contact our support team for

further investigation using following link: https://helpdesk.grandstream.com/

Ping/Traceroute

Ping and Traceroute are useful debugging tools to verify reachability with other clients across the network.
The GWN7610 offers both Ping and Traceroute tools for IPv4 and IPv6 protocols. To use these tools, go to
GWN7610 WebGUI-> System Settings-=>Debug and click on Ping/Traceroute.

D
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Target 192.168.1.187 Tool IPv4 Ping T

PING 192.168.1.187 (192.168.1.187): 56 data bytes

64 bytes from 192.168.1.187: seq=8 tt1=128 time=0.691 ms
64 bytes from 192.168.1.187: seg=1 tt1=128 time=0.388 ms
64 bytes from 192.168.1.187: seq=2 tt1=128 time=9.588 ms
64 bytes from 192.168.1.187: seqg=3 ttl=128 time=0.527 ms
64 bytes from 192.168.1.187: seq=4 tt1=128 time=0.347 ms

--- 192.168.1.187 ping statistics ---
5 packets transmitted, 5 packets received, 8% packet loss
round-trip min/avg/max = @.308/8.476/8.691 ms

Figure 50: IP Ping

¢ Next to Tool choose from the dropdown menu: - IPv4 Ping for an IPv4 Ping test to Target
- IPv6 Ping for an IPv6 Ping test to Target
- IPv4 Traceroute for an IPv4 Traceroute to Target
- IPv6 Traceroute for an IPv6 Traceroute to Target
e Type in the destination’s IP address/domain name in Target field.
e Click on Run.

Debug

Capture Core Files Ping/Traceroute Syslog

Target www.grandstream.com Tool IPv4 Traceroute v

traceroute to www.grandstream.com (45.55.195.232), 3@ hops max, 38 byte packets
1 192.168.6.1 ©.276 ms
41.245.224.1 98.518 ms
81.192.65.178 106.199 ms
81.192.85.169 99.246 ms
81.192.12.38 102.621 ms
149.14.125.77 122.121 ms
130.117.49.153 74.376 ms
154.54.56.129 112.268 ms
154.54.30.185 199.887 ms
154.54.31.1@ 188.64@ ms
154.54.12.18 184.659 ms
66.119.96.5 197.61@ ms

66.119.96.22 193.817 ms
S

Wom N B W

B e e e
Bowo R @

S

e
@

45.55.195.232 165.416 ms

Figure 51: Traceroute

Syslog

The syslog Web page displays logs generated by the GWN7610 for troubleshooting purpose as shown in
figure below.
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S GWN7610 rimware1.038 ® ‘ Q ‘ 155 w English v admin [

Debug

Capture Core Files Ping/Traceroute

. Fri May 19 09:45:48 2017 daemon.info poe: setting power state: high power (29 dBm)

ra

. Fri May 19 09:45:51 2017 daemon.info poe: setting power state: low power (29 dBm)

w

. Fri May 19 09:45:51 2017 daemon.info poe: setting power state: high power (29 dBm)

s

. Fri May 19 09:45:53 2017 daemon.debug controller: apsm_sm_unpaired: apsm_sm_unpaired: EVT_AP_HEARTBEAT

w

. Fri May 19 09:45:53 2017 daemon.debug controller: apsm_sm_unpaired: apsm_sm_unpaired: 000b828b4e28 EVT_AP_HEARTBEAT

@

. Fri May 19 09:45:54 2017 daemon.info poe: setting power state: low power (29 dBm)

-

. Fri May 19 09:46:00 2017 daemon.info poe: setting power state: high power (29 dBm)

@

. Fri May 19 09:46:03 2017 daemon.info poe: setting power state: low power (29 dBm)

o

. Fri May 19 09:46:04 2017 daemon.info poe: setting power state: high power (29 dBm)

10. Fri May 19 09:46:04 2017 daemon.debug controller: apsm_sm_unpaired: apsm_sm_unpaired: EVT_AP_HEARTBEAT

11. Fri May 19 09:46:04 2017 daemon.debug controller: apsm_sm_unpaired: apsm_sm_unpaired: 000b828b4dd4 EVT_AP_HEARTBEAT
12. Fri May 19 09:46:07 2017 daemon.info poe: setting power state: low power (29 dBm)

13. Fri May 19 09:46:10 2017 daesmon.info poe: setting power state: high power (29 dBm)

Figure 52: Syslog
Email /Notification

The Email/Notification page allows the administrator to select a predefined set of system events and to
send notifications upon the change of the set events.

Note:
A reboot is required in order to activate email notification feature.

Table 17: Email Setting

Filed ______|Desoription

Enabled Enable/disable the email settings. By default, it's disabled

Host Configures the SMTP Email Server IP or Domain Name.

Port Specifies the Port number used by server to send email.

Username Specifies sender’s User ID or account ID in the email system used.
Password Specifies sender’s password of the email account.

Email Address Specifies the email address of the administer where to receive notifications.

The following table describe the notifications configuration settings.

Table 18: Email Events

I L

Enabled Enable/disable the notification. By default, it's disabled
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Configures whether to send notification if memory usage is greater than the
Memory Usage _ o
configured threshold. By default, it’s disabled.

Memory Usage

Specifies the Memory Usage Threshold (%). Must be integer between 1 and 100.
Threshold (%)

Configures whether to send natification if CPU usage is greater than the configured

CPU Usage
threshold. By default, it's disabled.

CPU Usage

Specifies the CPU Usage Threshold (%). Must be integer between 1 and 100.
Threshold (%)

Firmware upgrade Configures whether to send notification on firmware upgrade. Default is disabled.
Add/Remove Configures whether to send notification when network groups has been
Network Group added/removed.

Configures whether to send notification if any additional SSID is enabled. Default
Additional SSID

is disabled.
Time Zone Change Configures whether to send notification on time zone change. Default is disabled.
Administrator Configures whether to send notification on admin password change. Default is
Password Change disabled.
AP Offline Configures whether to send notification when AP going offline. Default is disabled.
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UPGRADING AND PROVISIONING

Upgrading Firmware

The GWN7610 can be upgraded to a new firmware version remotely or locally. This section describes how
to upgrade your GWN7610.

Upgrading via WEB GUI

The GWN7610 can be upgraded via TFTP/HTTP/HTTPS by configuring the URL/IP Address for the
TFTP/HTTP/HTTPS server and selecting a download method. Configure a valid URL for TFTP, HTTP or
HTTPS; the server name can be FQDN or IP address.

Examples of valid URLs:
firmware.grandstream.com/BETA
192.168.5.87

The upgrading configuration can be accessed via Web GUI-> System Settings—> Maintenance 2> Upgrade.

Table 19: Network Upgrade Configuration

Fea _______|oeseripton |

Allow users to choose the firmware upgrade method: TFTP, HTTP

Upgrade Via
= or HTTPS.

Firmware Server Define the server path for the firmware server.

Allows the device to check if there is a firmware from the configured
Check Update on Boot
firmware server at boot.

Automatic Upgrade check
Set the value for automatic upgrade check in minutes.
interval(m)

Upgrade Now Click on button to begin the upgrade. Note that the

device will reboot after downloading the firmware.

Upgrading Slave Access Points

When the GWN7610 is being paired as slave using another GWN7610 Access Point acting as Controller,
users can upgrade their paired access points from the GWN7610 Master Controller.

To upgrade a slave access point, log in to the GWN7610 acting as Master Controller and go to Access
Points.
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Accass Poinks
Davice Type . m
s 5

D Type Hame ™Al [P Addreds Status Uptime Firmwars Actions
GWHISLO OS2 IBR4E24 192.168.5.122 Magier m 55 1038 m"
- GWNIE10 On0B:a2 R4 D: DA 192.168.5.158 Online 2h 25m 15¢ 1.0,2.13 L‘ﬂ\ ¢_’?
"
- GWNT&EL0 000852 1BR58:30 192.168.5.140 Onling h 25m 175 1.0.3.8 m’ ,::J
Showing 1-2 of 3 records). PerPage: (10 v

Figure 53: Access Points

Make sure that firmware server path is set correctly under Maintenance, check the desired APs to upgrade,

»

&S] rade YU

and click on to upgrade the selected paired access points, or click on L next to the paired
. . . . . Upgrade | .

device to access its configuration page, and click on —' to upgrade the device.
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Status

Device Name (2)
Fixed IP (2)

Frequency
Enable Band Steering (?)

2.4GHz

Mode (2)
Channel Width (2)
40MHz Channel Location (2)
Channel (7)
Enable Short Guard Interval (2)
Active Spatial Streams (2)
Radio Power (?)

Allow Legacy Devices(802.11b)

Device Configuration

Users

O
Dual-Band

O

802.11n
20MHz
Auto

Auto

LY

Auto

High

(W

Configuration

Figure 54: Device Configuration

The status of the device will show Upgrading, wait until it finishes and reboots, then it will appear online

again.

GWN7510

00:08:82:88:4D:D4

192.168.6.20

Upgrading

1d 22h 48m 29%

1.0.3.8

Figure 55: GWN7610 Upgrading

D
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A Notes:

e Please do not interrupt or power cycle the GWN7610 during upgrading process.
e The Master Access Point needs to be upgraded from Web GUI-> System Settings>Maintenance.
It cannot be upgraded from Access Points page like the Paired Access Points.

Service providers should maintain their own firmware upgrade servers. For users who do not have
TFTP/HTTP/HTTPS server, some free windows version TFTP servers are available for download from
http://www.solarwinds.com/products/freetools/free tftp server.aspx

http://tftpd32.jounin.net

Please check our Website at http://www.grandstream.com/support/firmware for latest firmware.

Instructions for local firmware upgrade via TFTP:

1. Unzip the firmware files and put all of them in the root directory of the TFTP server;
Connect the PC running the TFTP server and the GWN7610 to the same LAN segment;
Launch the TFTP server and go to the File menu->Configure->Security to change the TFTP server's
default setting from "Receive Only" to "Transmit Only" for the firmware upgrade;

4. Start the TFTP server and configure the TFTP server in the GWN7610 Web configuration interface;

5. Configure the Firmware Server to the IP address of the PC;

6. Update the changes and reboot the GWN7610.

End users can also choose to download a free HTTP server from http://httpd.apache.org/ or use

Microsoft IS Web server.
Provisioning and backup

The GWN7610 configuration can be backed up locally or via network. The backup file will be used to restore
the configuration on GWN7610 when necessary.

Download Configuration

Users can download the GWN7610 configuration for restore purpose under Web GUI->System
Settings>Maintenance.

Click on | Download to download locally the configuration file.
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Upload Configuration

Users can upload configuration file to the GWN7610 under Web GUI->System Settings->Maintenance

Click on |L| to browse for the configuration to upload.

Please note that the GWN7610 will reboot after the configuration file is restored successfully.

Configuration Server (Pending)

Users can download and provision the GWN7610 by putting the config file on a TFTP/HTTP or HTTPS
server, and set Config Server to the TFTP/HTTP or HTTPS server used for the GWN7610 to be provisioned

with that config server file.
Reset and reboot

Users could perform a reboot and reset the device to factory functions under Web GUI->System

| Reboot |

Settings>Maintenance by clicking on button.

‘L| Will restore all the GWN7610 itself to factory settings.
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EXPERIENCING THE GWN7610 WIRELESS ACCESS POINT

Please visit our Website: http://www.grandstream.com to receive the most up- to-date updates on firmware

releases, additional features, FAQs, documentation and news on new products.

We encourage you to browse our product related documentation, FAQs and User and Developer Forum
for answers to your general questions. If you have purchased our products through a Grandstream
Certified Partner or Reseller, please contact them directly for immediate support.

Our technical support staff is trained and ready to answer all your questions. Contact a technical support
member or submit a trouble ticket online to receive in-depth support.

Thank you again for purchasing Grandstream GWN7610 Wireless Access Point, it will be sure to bring
convenience and color to both your business and personal life.
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